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Signal Studio-802.11a software is a 
powerful tool for creating IEEE 
802.11a baseband I/Q waveforms 
for use with the Agilent ESG digital 
series signal generator’s dual 
arbitrary waveform generator. 

Main Features 
�� Intuitive user interface makes 

waveform creation fast and easy 
�� Plot spectrum and I/Q components 
�� Selectable framing includes 

Preamble and Header 
�� Raised cosine windowing 
�� Customize modulation and encoder 

settings including data rate, 
scrambling, interleaving, convolutional 
encoding, and MAC header 

��  Enable/disable FCS 
�� Remote control of basic ESG-digital 

series RF signal generator functions 
from software 

 



 

 
This Product Note is a self-guided tutorial that describes the test signals that can be created with the Signal Studio- 802.11a software.  
This document is not meant to be an IEEE 802.11a technology tutorial.  For additional information on 802.11a technology, refer to the 
References section at the end of this document. 
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Software Overview 
Signal Studio-802.11a software is a tool for creating an IEEE 802.11a waveform in an intuitive Windows®¹-based environment.  The 
software calculates a baseband I/Q waveform file based on the user-defined 802.11a frame.  The waveform file can then be downloaded 
to the ESG dual arbitrary waveform generator for playback.  
 
Try before you buy! Signal Studio can be downloaded free of charge for evaluation.  A license key is required to load the signals created by the 
software into the ESG Digital Series RF Signal Generator.  The license key can be ordered through your sales engineer or your local sales 
office, which can be found at http://www.agilent.com/find/assist.   
 
In addition to creating waveform files, the software provides basic configuration menus for signal generator settings, including frequency, 
amplitude, and marker polarity.  The instrument settings, along with the waveform files, are passed to the ESG signal generator over the 
GPIB or RS-232 interface.   
 
After downloading the waveform file and instrument settings, the ESG automatically begins generating the 802.11a RF signal.  Local 
control of the instrument is then re-enabled and signal generator settings, like frequency and amplitude, can be modified from the 
instrument’s front panel.  The waveform files themselves cannot be modified once they have been downloaded to the instrument.  
 
The waveform files can be saved in the ESG dual arbitrary waveform generator non-volatile memory for later recall.  If multiple waveforms 
are being created and the ESG non-volatile memory capacity becomes an issue, the Signal Studio-802.11a configuration can be saved to 
the host computer’s local hard drive.  The Signal Studio software configuration can then be recalled at any time to re-calculate and 
download the waveform to the signal generator. The waveform itself cannot be saved on the PC, but waveforms can be re-calculated 
quickly from stored settings. 
 
The Signal Studio-802.11a signal can be used to test baseband components of the receiver chain during the design process.  Some 
software engineers may require a baseband signal to perform demodulation and decoding verification on ASIC and DSP chips, see  
Figure 1.     
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IEEE 802.11a operates in the 5.150 to 5.350 GHz, and 5.725 to 5.825 GHz frequency bands.  The maximum frequency range of the ESG is 4 
GHz. The ESG can only be used to test 802.11a components at baseband or IF frequencies, not in the 5 GHz band.  If it is desired to 
transmit the signal in the 5 GHz frequency range, a mixer can be used to convert the 802.11a signal to the desired frequency range, see 
Figure 2 below.  The actual frequency parameters that would be used for each source, bandpass filter, and amplifier vary according to the 
specific mixer that is chosen.   
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Figure 2:  Converting a Test Signal to the 5 GHz Frequency Band 
 

Benefits 
 
Signal Studio-802.11a simplifies the user’s role in creating 802.11a test signals for use with the ESG digital series RF signal generator.  
Instead of wasting valuable time writing code to create a proprietary test signal, Signal Studio-802.11a provides the ability to quickly 
configure a standard-based test signal via an intuitive graphical user interface. Furthermore, the Signal Studio-802.11a frame 
configuration can easily be modified to create the desired test signal, without re-writing code. 
 
Component Test 
The performance characteristics of 802.11a components - including preamplifiers, combiners, filters, and amplifiers - is determined using 
a stimulus that provides statistically correct signals. The Signal Studio-802.11a software meets this need by providing statistically correct 
signals. Signal parameters, including the number of active subcarriers and modulation type, can be modified to provide adequate stress 
on the components being tested. 
 
Receiver Test 
In order to thoroughly test a receiver’s demodulation capabilities, a test signal with full channel coding is necessary. Full channel coding 
allows test engineers to determine if each functional stage of a receiver is operating correctly.  This level of channel coding enables PER 
and BER testing on the signal received by the Access Point to verify performance. 
The designer will be able to use this as a test signal to perform standards-based tests such as receiver minimum input level sensitivity, 
receiver maximum input level, and receiver adjacent and non-adjacent channel rejection measurements. 
 
Another benefit of using the Signal Studio-802.11a as a test signal is that it allows the designer to verify that the receiver decodes an 
independently generated 802.11a test signal correctly. 
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IEEE 802.11a OFDM Overview 
 
802.11a is an orthogonal frequency division multiplexed (OFDM) multicarrier signal.  In traditional FDM systems, the spacing between 
channels is greater than the symbol rate to avoid overlapping the spectrums.  However, in OFDM systems, the carriers overlap, which 
conserves bandwidth, but subcarriers don’t interfere with one another because they are orthogonal to one another.  Orthogonality implies 
that there is a mathematical relationship between the subcarriers, and there is.  Each subcarrier has an integer number of cycles in the 
FFT interval, and there is a difference of one cycle between adjacent subcarriers, and this is the reason orthogonality exists between the 
subcarriers.  Each subcarrier has a spectral null at all the other subcarrier frequencies 
 
The high rate data OFDM signal is divided into 52 slower parallel signals (subcarriers), and then an IFFT is applied to the signal, and these 
subcarriers are transmitted simultaneously.  The symbol duration increases for the lower rate parallel subcarriers, thus the relative 
amount of dispersion in time caused by multipath delay spread is reduced.  Phase noise and non-linear distortion contribute the most to 
loss of orthogonality, which results in intercarrier interference (ICI).  A guard interval is added to help prevent ICI, as well as intersymbol 
interference (ISI).  ICI will cause ISI.  However, ISI will not cause ICI.  A signal with a slower data rate is more resistant to multipath 
fading and interference.   

802.11a Occupied Bandwidth 
All the subcarriers are spaced equidistant to one another.  For 802.11a, the subcarriers are 312.5 kHz apart.  This spacing is determined by 
dividing the FFT sampling rate, 20 MHz, by the total number of samples in the FFT, which is 64 points in 802.11a.  One 802.11a symbol is 
comprised of 48 data subcarriers, and 4 pilot subcarriers, and one nulled subcarrier (zero subcarrier).  Thus the occupied bandwidth is 53 
subcarriers multiplied by the spacing of 312.5 kHz, which is 16.56 MHz.  The 802.11a standard specifies that the occupied bandwidth is 
16.6 MHz.   
 

Signal Studio-802.11a Baseband Data OFDM Symbol Creation  
Signal Studio-802.11a encodes the data according to the standard, which is shown in Table 1 on page 12.  The user’s data is scrambled, 
encoded, and interleaved.  Interleaving and scrambling can be toggled On/Off.  The forward error correction (FEC) that is added to the 
signal adds robustness to the symbol in the event the amplitude of any of the subcarriers diminish enough to create bit errors.     
 
The data rate and the modulation format are coupled in the Signal Studio software, so that when a data rate is selected, this will 
automatically select the modulation format as defined in the standard.   
 
After channel coding has been added to the data, and symbol mapping has been performed, a 64-point FFT is applied to the data, see 
Figure 3.  The data is mapped onto 48 data subcarriers, which are identified as subcarriers –26 to –22, -20 to –8, -6 to –1, 1 to 6, 8 to 20, 
and 22 to 26. This is shown in the Signal Studio software in the Subcarrier Setup Menu.  Each group of 48 data subcarriers makes up one 
OFDM data symbols.  Four pilot subcarriers are inserted for timing information for the receiver. 
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Afterwards, a guard interval is added to the symbol.  This guard interval helps prevent intersymbol interference from signal delay spreads 
caused by multipath commonly experienced over-the-air interface channel.  The guard interval needs to be larger than the delay spread to 
prevent ISI.   
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Figure 3:  Creation of an OFDM symbol 

 
The following diagram, Figure 4, illustrates the OFDM symbol structure.  Once the 64 point IFFT is performed, the last 16 bits of the 
symbol are appended to the front of the IFFT interval (called the guard interval or cyclic prefix) to create the symbol, which is 80 samples 
long.  Then the first 16 bits of the IFFT are inserted at the end of the symbol.  This cyclic post-fix allows the user to apply a raised cosine 
window to each OFDM symbol.  At the symbol boundaries, the modulation creates sharp phase transitions that increase the out-of-band 
energy of the signal.  The raised cosine window smoothes these transitions, thus reducing the out-of-band energy.  This can be 
demonstrated with the Signal Studio-802.11a software by varying the range of the window, and plotting the spectrum, as shown in 
Figures 5 and 6.   
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Figure 5:  Spectrum plot of 802.11a I/Q waveform 
with Windowing Length=0 samples (no windowing) 

 
 
 

Raised Cosine Windowing 
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Signal Structure 

PMD Layer 
The Signal Studio-802.11a creates the physical layer PMD (physical medium dependent) test signals, which contain PLCP (physical layer 
convergence procedure) Preamble, PLCP Header, and payload data, see Figure 8.   
 
Although the signal does not provide MAC or PLCP protocol handling, it does enable testing of the PMD for receiver and component tests. 
 

802.11a Standard specifies these 3 layers

MAC 

Software provides framing and coding  for 
this layer 

 
 
 
 
 
 

Figure 8:  80
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 FCS to the data payload.  This is useful if the user needs to add addresses or 
ad data, see Figure 10.  Also the FCS can be used to perform packet error ratio 
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Frame Structure 
In 802.11a systems information is transmitted is in frames.  This framed information makes up a packet, which is bursted.  During the burst 
the entire packet is transmitted, then the carrier is blanked or idle for a certain interval.  This interval can be set in the software.   All data in 
the frame is OFDM encoded.  The total frame length is variable.  Figure 9 illustrates the frame structure of the signal created by Signal Studio-
802.11a software.  The signal is created according to IEEE-802.11a specifications.   
 
The 802.11a burst has four distinct regions.  The preamble contains two of those regions.  The preamble is BPSK modulated at 6 Mbps.  The 
preamble contains no channel coding, and is not scrambled.  The first region of the preamble consists of a short preamble.  The short 
preamble contains 10 short symbols assigned to subcarriers -24,  -20, -16, -12, -8, -4,  4,  8, 12, 16, 20, 24.  The second part of the preamble 
contains 2 long symbols that are assigned to all 52 subcarriers.  The third region of the packet is the Signal (header), which consists of one 
symbol assigned to all 52 subcarriers.  This symbol is BPSK modulated at 6 Mbps and is encoded at a ½ rate.  The Signal is not scrambled.  
The last region of the packet consists of the Service field and the data payload.  This region is scrambled.  The data rate, encoding rate, and 
modulation varies, see Figure 10.  Notice that guard intervals (GI) are added to the long preamble, header (Signal field), and the Service and 
payload data.   
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Figure 10 shows the detailed diagram of the Signal Studio-802.11a framing.   
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Payload Structure 
The payload field is within the PPDU frame.    A MAC header and FCS can be added to the user’s data.   Table 1 provides a summary of the 
payload characteristics in 802.11a.   
 
 

Data Rate 
Mbps 

Modulation 
 

Encoding 
rate 

Coded bits per 
subcarrier 

 Coded bits per 
symbol 

6 BPSK ½ 1 48 
9  BPSK ¾ 1 48 
12  QPSK ½ 2 96 
18  QPSK ¾ 2 96 
24 QAM-16 ½ 4 192 
36 QAM-16 ¾ 4 192 
48 QAM-64 2/3 6 288 
54 QAM-64 ¾ 6 288 

Custom Variable Variable Variable Variable 
 Table 1.  Key 802.11a payload characteristics supported with the Signal Studio-802.11a software 

 
Figure 11 is an illustration of the payload structure.  The payload data (user’s data) is called PLCP service data unit (PSDU) in the standard. 
The description and details of the medium access control (MAC) header and frame check sequence (FCS) can be found in the IEEE 802.11 
standard.  The MAC header and FCS state can be toggled On/Off.  All the fields in the MAC header can be modified.   
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Figure 11:  Payload Structure 
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Creating Signals 
 
An 802.11a waveform can be can be configured and downloaded to the ESG digital series RF signal generator in four easy steps: 

Step 1 – Configure the 802.11a signal, including the MAC Header and subcarrier setup 

Step 2 - Setup the Signal Generation Options 

Step 3 - Configure the ESG 

Step 4 - Calculate & Download 

Step 1 – Configure 802.11a signal, including the MAC Header and Subcarrier Setup 
 

                  
 

                                   
 

                                                                                                    
 

Figure 12:  Signal Studio-802.11a Signal Configuration menu 
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Signal Configuration 
The Signal Configuration user interface section allows the user to choose specific parameters for the framing of the signal.  Notice that you 
can choose framing, or turn it off.  A framed signal is needed in receiver tests, and an unframed signal would be useful in component tests, or 
other instances where continuous, opposed to bursted, modulation of unframed data is desired. 
 
Framed:   Toggles between framed and unframed mode.  In framed mode the user can generate a test signal to make measurements 
according to the standard.  In unframed mode, the user can perform measurements where non-framed and non-bursted data is desired. 
Data Rate:  Selects the data rate.  Nine different data rates are available:   
6 Mbps, 9 Mbps, 12 Mbps, 18 Mbps, 24 Mbps, 36 Mbps, 48 Mbps, 54 Mbps and Custom.  Custom allows arbitrary selection of encoding rates 
and modulation schemes.  Otherwise, the data rate selected will automatically set the modulation and encoder rate according to the 802.11a 
standard.   
Modulation:  For all the data rates, except Custom, the modulation formats are set according to the 802.11a specification and cannot be 
changed.  The following modulation formats are available: 

�� BPSK 
�� QPSK 
�� 16-QAM 
�� 64-QAM 

Encoder:  For all data rates, except Custom, the encoder rate automatically sets the data rate and modulation scheme.  When inactive is 
selected, Custom data rate allows the user to select the desired modulation scheme and no encoding rate.  The following encoding rates are 
available: 

�� Inactive 
�� 1/2 
�� 2/3 
�� 3/4 

Scrambler Active:  Toggles the activity state of the scrambler.   
Scrambler Initialization:  Sets the initial value of the scrambler.  Valid range is any 7-bit value, Hexadecimal representation. 
Interleaver Active:  Toggles the activity state of the interleaver. 
Idle Interval:  Sets the length (in microseconds) of the idle time between frames.  This is only relevant in framed mode.   
 
Sub-Carrier Setup 
This menu configures the individual sub-carriers.  There are a total of 52 sub-carriers for an 802.11a signal, 48 of those signals are data 
subcarriers, and 4 are pilot subcarriers.  The center frequency, which is the zero subcarrier, is nulled.   The state of each of the subcarriers can 
be toggled On/Off, or the user can select from some predefined set-ups as follows: 

�� All 
�� Every 2nd 
�� Every 4th 
�� Upper band 
�� Lower band 
�� Outer band 
�� Outer pair 
�� None (not allowed) 

 
Payload Setup 
This section allows the user to configure the MAC header and choose to have an FCS added to the packet.  The maximum data length of the 
user data in the payload is 4095 bytes, which includes the MAC header and FCS.  Notice that the total length of the entire payload is 
displayed.   
 
Setup menu:  Configures the MAC header. 
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MAC Header:  Enables/disables prepending the MAC header to the data payload.  The user can set all these individual fields with the desired 
data, and the user can disable these fields if the data is no longer desired.   
MAC FCS: Enables/disables appending the MAC FCS to the data payload. The FCS (frame check sequence) is automatically calculated by the 
software if this field is selected. 
Data Type:  Selects the payload data stream, and can contain the following data: 

�� PN9 
�� PN15 
�� All zeros 
�� All ones 
�� Alternating zeros and ones 
�� Alternating ones and zeros 

Data Length:  Sets the number of data bytes in a frame.  This excludes MAC header and FCS.   
Total Length:  Displays the total number of bytes in the payload.  This includes the data and MAC header and FCS. 
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Step 2 - Setup the Signal Generation Options 
 

 
 

Figure 13:  Signal Studio-802.11a Signal Generation Options menu 
 

Signal Generation Setup 
 
As illustrated in Figure 13, the Signal Studio software provides a simple interface for defining the following signal generation options:  
Oversampling Ratio, Windowing Length, and Mirror Spectrum. 
 
Oversample Ratio 
The over sampling ratio (OSR) defines the number of samples calculated per I/Q symbol. Increasing the over sampling ratio of the 
constructed signal increases the separation of the sampling images from the desired signal.  This allows for better image rejection by the 
baseband reconstruction filters.  However, the improved image rejection comes with a price.  Increasing the over sampling ratio increases 
the waveform calculation time and file size.  Notice that the projected file length in the Signal Information section is affected by the over 
sampling ratio setting.    
The software offers two different OSRs of 1 and 2.  When an OSR is selected, this automatically sets the Sampling Rate in the ESG 
Configuration section.  The lower the sample rate, the less space the waveform takes up in memory, and the faster the signal can be 
generated and downloaded.    
The maximum sampling rate on the ESG is 40 MHz.  The ESG provides three reconstruction filters (250kHz, 2.5MHz, 8MHz) and a no filter 
option (through).  The bandwidth of the baseband signal dictates the minimum reconstruction filter bandwidth to be used.    The 
reconstruction filters remove frequency images.  These low-pass filters are intended to transmit the baseband signal while rejecting the 
higher frequency images. 
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When using the reconstruction filters available on the ESG, part of the desired higher frequency components of the 8.3 MHz wide 
baseband 802.11a signal will be cut off.  To prevent this from happening, it is suggested that an external reconstruction filter be used, see 
Figure 14.  When using an external reconstruction filter, set Reconstruction Filter in the ESG Configuration section to Through.     
 

External low-pass filters  

Figure 14:  ESG Set Up with Exte
 
 
 
 
The reconstruction filter should have at least 8.3 MHz bandwidth, which
allows the entire desired signal to pass through, while rejecting the ima
 
For more information on reconstruction filters, and oversample ratios, re
 
Windowing Length 
 
A raised cosine time-domain window is applied to the baseband signal 
reduce out-of-band power.  The user can select the length of the raised
 
Mirror Spectrum 
This allows the user to invert the spectrum.  If this option is selected,
user plans to use a mixer to up convert the RF signal to the 5 GHz frequ

 

ESG
 
rnal Reconstruction Filters 

 is the baseband bandwidth of 802.11a.  These reconstruction filters 
ges that occur at multiples of the OSR.     

fer to [4].   

after the inverse Fourier transform is applied to the signal to 
 cosine window.  The range is 0 to16 samples.   

 then the Q channel is inverted.  This feature may be useful if the 
ency band.   
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Step 3 – Configure the ESG 
 

 
 

Figure 15:  Signal Studio-802.11a Signal Generation ESG menu 
 
Along with the compiled waveform, the Signal Studio software passes instrument settings to the ESG signal generator.  These are 
defined in the ESG Configuration menu.  The following settings can be made: 
 
 
 
 
 
 

ESG Configuration Parameters 
Frequency Defines the frequency at which the ESG will generate the signal. 
Amplitude Defines the power at which the ESG will generate the signal. 
Sampling Rate This parameter is automatically set when the over sampling ratio is defined in 

the Signal Generation Options menu.  It is the rate at which the waveform I/Q 
samples are read from the dual arbitrary waveform generator memory during 
playback. 

Reconstruction Filter The ESG provides three reconstruction filters (250kHz, 2.5MHz, 8MHz) and a no 
filter option (through).  The bandwidth of the baseband signal dictates the 
minimum reconstruction filter bandwidth to be used.    Depending on the over 
sampling ratio and where the image frequencies appear, a wider bandwidth 
reconstruction filter may be selected.  For more information on reconstruction 
filters refer to [4] 
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RF Blanking When the 802.11a signal is framed, RF Blanking improves the on/off ratio of the 
RF bursts.  The ESG Event 2 marker is internally routed to provide the RF 
Blanking signal.  
 
Note:  When RF Blanking is enabled, the Marker Polarity, the +Mrkrs button, 
must be set to positive or the wanted RF signal will be blanked resulting in no RF 
output from the ESG. 

Internal/External 
Reference Frequency 

Sets reference frequency for the ESG dual arbitrary baseband generator to 
internal or external. If an external reference is used, it should be connected to 
the ESG before the waveform and instrument settings are downloaded to the 
instrument. 

Marker Polarity  Toggles between positive/negative and sets the polarity of the Event 1 and 
Event 2 markers.    When RF Blanking is activated, the Event 2 marker is 
internally routed to provide access to the RF Blanking signal.  Access to these 
signals is provided on the Event 1 and Event 2 ports on the rear panel of the ESG. 

 
After the waveform and instrument settings have been downloaded to the instrument, only the instrument settings can be modified from 
the signal generator front panel.  The waveform itself cannot be modified, except by recalculating with new settings in the Signal studio 
software. 
 

Step 4a - Calculate  
 

 
 

Figure 16.  Signal Studio-802.11a Calculate and Download menu. 
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Once the waveform and ESG settings have been configured, the final step is to calculate the waveform and download it to the 
instrument.    
First name the waveform in the Waveform Title field.  This is the name that will appear in the ESG user interface after the waveform is 
downloaded to the instrument.  The ESG only recognizes waveforms that are named using the following alphanumeric characters:  A thru 
Z, 0 thru 9, $&_#+-[ ].  There is a 20-character maximum name length for waveform files.  If un-supported alphanumeric characters are 
used to name the waveform, the ESG will generate a File Name Not Found Error (Error: -256) when the waveform is downloaded to the 
instrument.   
 
Select the Calculate button.  The software will generate an I/Q waveform file in accordance with Signal Studio settings.  Waveform 
calculation time varies according to the selected data rate, OSR, data length of the payload, and the computer’s processing speed.  
Creating the maximum frame length of 5.84 ms took 10 minutes with a PC with clock speed of 533 MHz and with a 2Pentium�III 
processor.   
 
After the I/Q waveform has been calculated, the Signal Studio software is capable of generating a plot of the baseband spectrum and the 
I/Q waveforms. To plot the spectrum, choose Plot→ Spectrum from the menu keys at the top of the window, Figure 17. The plot can be 
magnified using the zoom feature in the Tools pull-down menu at the top of the plot. Simply select the zoom feature and use the mouse 
pointer to select the section of the plot to be affected. Plots of the I/Q waveforms can be generated in a similar manner.  
 

 
 

Figure 17.  Spectrum plot of Signal Studio-802.11a I/Q waveform. 
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Signal Studio Configuration and Setup 
See the Signal Studio Installation Guide [1] for more details on connecting the computer to the ESG.   
 
The ESG will be connected to the PC as shown in Figure 18.   
 
 
 
 

GPIB or RS-232

RF Output 
 

Rear Panel 

ESG digital 
W/ 

Option UND 

 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 18.  PC to ESG Configuration 
 

Step 4b - Download  
 
Select Download button (see Figure 16) to send the calculated I/Q waveform file representing the 802.11a and the signal generator 
settings to the instrument.  The signal generator automatically begins producing the 802.11a RF signal.  Local control of the instrument is 
then re-enabled and signal generator settings can be modified from the instrument’s front panel.  The waveform files themselves cannot 
be modified once they have been downloaded to the instrument.   
 
The Signal Studio-802.11a software configuration can be saved to the host computer’s local hard drive.  The configuration can then be 
recalled at any time to re-calculate and download the waveform to the signal generator.  This is especially useful when complex 
configurations have been created in the software.  From the menu keys at the top of the window in Figure 16, choose File → Save As, 
and then name the file and save it in the ESG-B/Dot11a directory.  The software configuration can be recalled anytime by choosing the 
following menu options:  File → Open, then the file name.   
 
After the calculated I/Q waveform has been downloaded to the signal generator for playback, it can be saved in the instruments non-volatile 
memory for storage and later recall.  For more information on saving waveforms to the instrument, refer to the ESG Family Signal Generator 
Option UND Dual Arbitrary Waveform Generator Users and Programming Guide.  The I/Q waveform files created by the Signal Studio software 
cannot be stored outside the instrument. 
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Basic Measurements 
Required equipment: 
E443xB ESG Digital Series RF Signal Generator.  (x=0 through 7). 
Arbitrary Waveform Generator, Option UND 
Signal Studio-802.11a, Option 410 License Key 
89600 Series Vector Signal Analyzer  
 
The following measurements illustrate some of the typical characteristics of the Signal Studio-802.11a waveform that was generated and 
transmitted from the ESG.  Most of these measurements were set up with the same parameters as shown in Figure 16. 
 

            
 Figure 19:  Spectrum plot of Signal Studio-802.11a 

I/Q waveform with all 52 Subcarriers On 
Figure 20.  Spectrum plot of Signal Studio-802.11a 
I/Q waveform with every 4th Subcarrier On  
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Figure 21:  89640A VSA Spectral Measurement of 
Signal Studio-802.11a signal with all 52 Subcarriers
On 
Note:  Averaging is on  
Figure 22:  89640A VSA Spectral Measurement 
of Signal Studio 802.11a signal with every 4th 
Subcarrier On 



 

 
 

Figure 23:  89640A VSA Power Spectral Density Measurement of Signal Studio-802.11a Signal 
 
Figure 23 shows a power spectral density (PSD) measurement of the Signal Studio-802.11a signal.  The VSA span is set to 30 MHz.  The 
frequency start begins at 1 GHz and stop frequency is set to 1.03GHz.   The above span only shows the half of the transmitted signal at fc 
(center frequency of the signal) + 30 MHz.  The measurement shows the signal is –52.77 dBr at 1.03 GHz.  The transmitted signal must be   
� - 40 dBr at fc > � 30 MHz and greater (see Table 2 below).  To reject the undesired higher frequency components and images (not shown in 
the above measurement), it is recommended to use an external reconstruction filter.  The IEEE 802.11a standard specifies that the 802.11a 
PSD measurements meet the requirements shown in Table 2.  
 

dB relative to maximum spectral density 
 of signal 

Frequency offset  

–20 dBr fc  >� 9 to 11 MHz 
–20 to –28 dBr fc  >� 11 to 20 MHz 
–28 to –40 dBr fc >� 20 to 30MHz 
� - 40 dBr   fc > � 30 MHz and greater 

Table 2:  IEEE 802.11a Transmitted Spectral Requirements 
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Figure 24:  Signal Studio-802.11a I/Q Components Plot 
 

 

Payload:   
8 � seconds 
51 symbols

Short Preamble:  
8 � seconds  
10 short symbols  

Long Preamble:  
8 � seconds  
2 long symbols  

Header:   
4 � seconds  
1 symbol

 
Figure 25:  89640A VSA Time Domain Measurement of Signal Studio-802.11a Signal 
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Short training 
symbols 

 
Figure 26:  89640A VSA Spectrogram of Signal Studio-802.11a Signal 

 
The spectrogram shown in Figure 26 shows a bursted 802.11a packet that is 28 � seconds long .  Each spectrum measurement is 
flattened to one row of pixels.  Since height can no longer be used to represent amplitude, color is used instead.  The spectrogram 
display is useful for looking at the time-varying spectral characteristics of a burst.  The following are some of the attributes of this 
display:   

�� Red represents a large signal level  
�� Green represents a mid signal level, the bursting of the packet in the above plot 
�� Blue represents a low signal level  
�� The (horizontal) frequency axis is the same as for a regular spectrum display.   
�� The vertical axis is now time instead of amplitude. 
�� The top of the spectrogram trace is the start of the burst and the bottom, the end.   

Notice that the short training symbols are added to subcarriers:-24,  -20, -16, -12, -8, -4,  4,  8, 12, 16, 20, 24 , and the subcarriers  show 
the most energy.   
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Figure 27:  89640A VSA Constellation and Equalizer Measurements of Signal Studio-802.11a Signal 
 
For 802.11a, the constellation will change depending on the data rate.  Unlike QPSK, the OFDM constellations don’t have all of the 
symbols at the same amplitude (distance from the origin).  The OFDM constellations are normalized to unity power.  For this reason, the 
EVM computation does not need to be normalized -- provided the transmitted data produces a uniform distribution of constellation points.  
A more rigorous approach to EVM computation (than provided by the standard) would not assume a uniform distribution of transmitted 
symbols and would instead factor in the average power level of the ideal symbols actually transmitted. 
 
This plot, see Figure 27,  shows an OFDM constellation in the upper trace.  It is a composite plot of all carriers over all symbols.  The 
constellation is a composite of the BPSK carriers and the 16-QAM carriers.  Also shown in the lower trace, is the adaptive equalizer 
response.  In 802.11a, the long training symbol is used to train an equalizer.  This is a required step in the measurement process.  The 
complex equalizer result can be viewed as magnitude, phase or group delay.  The magnitude and phase responses are shown above.  The 
equalizer result is a good measure of transmitted flatness and carrier power levels. 
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Data Sheet for Signal Studio-802.11a 
 
Framing �� Framed: bursted packets includes a PLCP Preamble (short and long) and Header 

(Signal field) 
�� Non-framed:  Continuous non-bursted payload data (no PLCP Preamble and 

Header added to payload 
Raised cosine windowing  Range:  0-16 samples 
Convolutional encoding ½, 2/3, and ¾ rate 
Modulation formats BPSK, QPSK, 16-QAM, 64-QAM 
Data source 1s, 0s, 01s, 10s, PN9, PN15 
Data rates 6,9,12,18,24,36,48,54 Mbps and Custom data rate 
Custom data rate Modulation:  BPSK  Encoder:  Inactive  Data rate:  12 Mbps 

Modulation:  QPSK  Encoder:  Inactive  Data rate:  24 Mbps 
Modulation:  16-QAM Encoder:  Inactive  Data rate:  48 Mbps 
Modulation:  64-QAM Encoder:  Inactive  Data rate:  72 Mbps 
Modulation:  BPSK  Encoder:  2/3  Data rate:  8 Mbps 
Modulation:  QPSK  Encoder:  2/3  Data rate:  16 Mbps 
Modulation:  16-QAM Encoder:  2/3  Data rate:  32 Mbps 
Modulation:  64-QAM Encoder:  1/2  Data rate:  36 Mbps 

Data length Maximum 
�� Without MAC Header and FCS:  4061 Bytes 
�� With MAC Header and FCS:  4095 Bytes 

Minimum 
�� 1 Byte 

Idle interval between frames Range:  0-1000 microseconds 
Subcarrier setup Range:  -1 to –26, and 1 to 26.  Individually selectable.  All or any subcarrier 

configuration; except none. 
Service field 16 bit Hex (First 7 LSB are masked to zero). 
Scrambler seed initialization value 7 bits Hex 
Oversample ratio 1,2 
Frame length Range:  24 microseconds to 5.484 milliseconds 
Sample length Maximum:  259,360 samples 
 

 
26 

 



 

 

Acronyms and Abbreviations 
16-QAM  16 point quadrature amplitude modulation 
64-QAM  64 point quadrature amplitude modulation 
BPSK  binary phase shift keying 
dBr  dB relative to the maximum power spectral density of the signal 
fc  center frequency 
FCS  frame check sequence. 
FDM  frequency division multiplexing 
ICI  intercarrier interference 
ISI  intersymbol interference 
I/Q  in-phase/quadrature 
IEEE  Institute of Electrical and Electronics Engineers 
OFDM  orthogonal frequency division multiplexing 
QPSK  quadrature phase shift keying 
MAC  medium access control 
OSR  oversample ratio 
PHY  physical layer 
PLCP  physical layer convergence procedure 
PMD  physical medium dependent 
PPDU  PLCP protocol data unit 
PSD  power spectral density 
PSDU  PLCP service data unit 
RF  radio frequency 
WLAN  wireless LAN 

Additional Literature 
[1] Signal Studio Installation Guide 
 Available @ http://www.tm.agilent.com/data/downloads/eng/tmo/EPSG084705.pdf 
[2] Agilent ESG Family of RF Signal Generators - Data Sheet 
Literature Number 5965-3096E 
[3] Agilent ESG Family/RF Signal Generators - Configuration Guide 
Literature Number 5965-4973E 
[4] Generating Digital Modulation with the Agilent ESG-Digital Series Dual Arbitrary Waveform Generator 
Literature Number 5966-4097E 
[5] ESG Family Signal Generators Option UND Dual Arbitrary Waveform Generator Users and 
Programming Guide 
Literature Number E4400-90328 
[6]  Agilent 89600 Series Wide Bandwidth Vector Signal Analyzers 
Literature Number  5980-0723E 
More information on the 89600 VSAs can be found at:  www.agilent.com/find/89600 
 

References 
IEEE Std 802.11 1999 Standard 
IEEE Std 802.11a-1999 Standard 
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IEEE 802.11 Handbook By Bob O’Hara and Al Petrick ISBN # -0-7381-1855-9 
OFDM For Wireless Multimedia Communications By Richard Van Nee and Ramjee Prasad ISBM # 0-89006-530-6 

Ordering Information 
Signal Studio-802.11a is Option 410 for the Agilent ESG digital series signal 
generators. 
 
ESG digital: Standard Models 

E4430B – ESG digital series RF signal generator, 1 GHz 
E4431B – ESG digital series RF signal generator, 2 GHz 
E4432B – ESG digital series RF signal generator, 3 GHz 
E4433B – ESG digital series RF signal generator, 4 GHz 

ESG-digital:  High Spectral Purity Models 
E4434B – ESG digital High Spectral Purity series RF signal generator, 1 GHz 
E4435B – ESG digital High Spectral Purity series RF signal generator, 2 GHz 
E4436B – ESG digital High Spectral Purity series RF signal generator, 3 GHz 
E4437B – ESG digital High Spectral Purity series RF signal generator, 4 GHz 

 
The Signal Studio software requires that the ESG is equipped with the optional dual arbitrary waveform generator (Option UND). 
Firmware Revision B.03.75 is required to activate the License Key on the ESG-signal generator. 
 
Try before you buy! Download the software free of charge for evaluation by visiting http://www.agilent.com/find/signal_studio. 
However, to load the signal created by the software into the ESG, a license key must be purchased. The license key can be ordered 
through a sales engineer or local sales office. Contact information for both can be found at http://www.agilent.com/find/assist. 
 

Upgrade Kits 
If you already currently own an ESG and are interested in obtaining an upgrade kit only (license key), order: 
E4430BK Option 410. 
 
 
 
 
 
 
 
 
 
 
 
 
 
¹Windows is a U.S. registered trademark of Microsoft Corporation 
2Pentium is a U.S. registered trademark of Intel Corporation. 
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Agilent Technologies’ Test and Measurement Support, 
Services, and Assistance 
Agilent Technologies aims to maximize the value you 
receive, while minimizing your risk and problems. We strive 
to ensure that you get the test and measurement 
capabilities you paid for and obtain the support you need. 
Our extensive support resources and ser-vices can help you 
choose the right Agilent products for your applications and 
apply them successfully. Every instrument and system we 
sell has a global warranty. Support is available for at least 
five years beyond the production life of the product. Two 
concepts underlie Agilent's overall support policy: “Our 
Promise” and “Your Advantage.” 
 
Our Promise 
Our Promise means your Agilent test and measurement 
equipment will meet its advertised performance and 
functionality. When you are choosing new equipment, we 
will help you with product information, including realistic 
performance specifications and practical recommendations 
from experienced test engineers. When you use Agilent 
equipment, we can verify that it works properly, help with 
product operation, and provide basic measurement 
assistance for the use of specified capabilities, at no extra 
cost upon request. Many self-help tools are available. 
 
Your Advantage 
“Your Advantage” means that Agilent offers a wide range 
of additional expert test and measurement services, which 
you can purchase according to your unique technical and 
business needs. Solve problems efficiently and gain a 
competitive edge by contacting us for calibration, extra-
cost upgrades, out-of-warranty repairs, and on-site 
education and training, as well as design, system 
integration, project management, and other professional 
services.  Experienced Agilent engineers and technicians 
worldwide can help you maximize your productivity, 
optimize the return on investment of your Agilent 
instruments and systems, and obtain dependable 
measurement accuracy for the life of those products. 

By internet, phone, or fax, get assistance 
with your test and measurement needs 
Online assistance: 
http://www.agilent.com/find/assist 
 
Phone or Fax 
United States: 
(tel) 1 800 452 4844 
Canada: 
(tel) 1 877 894 4414 
(fax) (905) 282 6495 
Europe: 
(tel) (31 20) 547 2323 
(fax) (31 20) 547 2390 
Japan: 
(tel) (81) 426 56 7832 
(fax) (81) 426 56 7840 
Latin America: 
(tel) (305) 269 7500 
(fax) (305) 269 7599 
Australia: 
(tel) 1 800 629 485 
(fax) (61 3) 9210 5947 
New Zealand: 
(tel) 0 800 738 378 
(fax) 64 4 495 8950 
Asia Pacific: 
(tel) (852) 3197 7777 
(fax) (852) 2506 9284 
 
Product specifications and descriptions 
in this document subject to change 
without notice. 
Copyright © 2001 Agilent Technologies 
Printed July 9, 2001 
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